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Audit Trail (Spectrum Enhanced Security only)

All data, settings and actions carried out by a user in Spectrum ES are saved to a
database, grouped into user environments known as workspaces. A workspace is an
collection of software settings, custom layouts, objects such as equations and macros,
and user data. A new workspace, with a unique Workspace ID, is created each time a
user starts Spectrum ES (unless the user selects to reload their current workspace next
time, when they exit the software).

A Spectrum database has a default maximum size of 5 GB. When it reaches this size, a
new database is automatically created. Refer to Additional Information below for the
default location of the database.

Any activity that affects the way data is collected or stored is recorded in the workspace
Audit Trail. Entries are written to the Audit Trail at the point where a change that has
been made affects the recording of data. For example, changes to instrument settings
are only applied to the instrument when the Scan button is pressed, and so that is when
the change is recorded in the Audit Trail. This means that any changes made to settings
that are subsequently cancelled without being used are not recorded.

Some changes to the Audit Trail may require a "signature" from the user. Details of the
signature will be added to the Audit Trail. These signature points are predefined and
cannot be added to, but members of the Administrators group can define which actions
will require a signature. Refer to Signatures for more information.

When the Audit Trail dialog is displayed, the Audit Trail of the current workspace is
shown by default. However, you can use the filters on the Audit Trail dialog to view other
workspaces in the database(s). Members of the Users group can only view workspaces
they have created. However, members of the Administrators group can view the Audit
Trail for all workspaces. Also, members of the groups Reviewers and Approvers can view
the Audit Trail of workspaces that have been locked by other users for review or
approval.

You can select a saved workspace in the Audit Trail and then load it in Spectrum. This
means that you can continue working on a previously saved workspace. Also, if you have
Review or Approve permissions you can check work completed by another user. Refer to
Reviewing and Approving for more information.

Members of the Administrators group can load any workspace, although the workspace
will be read-only.

Viewing the Audit Trail

To view the Audit Trail of a workspace:
>  Select Audit Trail from the Audit Trail menu.
The Audit Trail dialog is displayed. The current workspace is displayed by default.

If Show details is selected, the lower part of the dialog shows the detailed Audit
Trail for the selected workspace.

To exit the Audit Trail dialog, click Close.
Selecting the Workspace

You can use the filtered list of available workspaces to select the one you want to view.
The Audit Trail for the current workspace is displayed by default.

Members of the Users group an only view workspaces they have created. Members of the
Administrators group can view all workspaces.



Audit Trail (ES only) . 475

Members of the Reviewers and Approvers groups can select For Review or For Approval,
as applicable, to display workspaces that have been locked by their creator, indicating
that they are ready for review and/or approval. All other user workspaces are hidden.

To select a workspace:

1.

From the Database selection drop-down list select the database that contains
the workspace(s) you would like to view.

The drop-down list contains any Spectrum ES databases at the database location.
Refer to Additional Information below for the default location of the database.

Select the appropriate filter from the Workspace selection drop-down list.

The options are Current Workspace, When created, Last modified, Signed,
Reviewed, Approved, Returned, For Review, and For Approval.

Current Workspace is selected by default.
Enter or select the start date and time in the From field.

Click the drop-down arrow to display a calendar and select the date. Or click in
the field and use the up and down arrows to increase or decrease a value,
respectively, or type a new value.

This option filters the list of workspaces so that only those with a Time and Date
stamp including and after the time and date entered will be displayed. For
example, if Last modified is selected as the Workspace selection, only those
workspaces last modified at times including and after the From entry will be
displayed.

If Current Workspace is selected as the Workspace selection, From is not
available.

To display workspaces created by a particular user select the user name from the
Creator ID drop-down list.

OR

To display workspaces created by all users in the database select All from the
Creator ID drop-down list.

Creator ID is only available if you have the appropriate permissions, which
depend on the Workspace selection. Current User is selected by default.

Members of the Users group can only view workspaces they have created.
Members of the Administrators group can view all workspaces. Also, members of
the groups Reviewers and Approvers (or any other groups with Review or
Approve permissions) with For Review or For Approval selected as the Workspace
selection can display workspaces by other users. Those workspaces must have
been locked by their creator, indicating that they are ready for review and/or
approval.

Select the maximum number of workspaces you want to display.

The workspaces with the most recent Time and Date stamps will be displayed.
If Current Workspace is selected, Number of workspaces is not available.
The list of workspaces is now filtered by your selections.

Click the left mouse button in the row of the Workspaces table for the workspace
you would like to view.

The Audit Trail displayed is updated the selected workspace.



476 . Spectrum User’s Guide

Audit Trail

The Audit Trail area, in the lower part of the screen, shows a chronological list of
activities performed within the workspace (with the most recent at the top). You can
select which columns to display in the table using the column selector in its top left

corner.

The available columns are:

Category — provides an overview of the type of action that has been audited.
For example, Setup or Administration.

Subcategory — provides the sub-menu grouping. For example, if the category is
Setup, an example sub-category is Instrument and Accessory; or, if the category
is Administration, an example sub-category is Users.

Audit - the audit entry indicates what type of setting was changed. For example,
for a Setup category with a sub-process Instrument and Accessory, the Audit
entry would be Instrument Settings, if one of the instrument settings was
changed.

Audited items — provides the detail of which setting was changed. For example,
the Scan Type.

Old Value - the previous value applied to the configuration that was changed.
For example, the Scan Type was Background.

New Value — the value applied when the configuration change was made. For
example, the Scan Type is Sample.

Time and date — the date and time of the change.

Workspace ID — the unique ID of the current workspace.

The following additional columns are relevant for Audited items that required a signature:

Sign point — the type of signature point, for example, Sign Workspace. For a list
of the signature points in Spectrum ES, and how to set up signature points, refer

to Signatures.
Signature — the signature of the user (this is the same as the User name).

Signature (full name) — the full user name of the user.

Reason — the reason given for the signature. The reasons available for a
signature point are defined by the administrator; refer to Signatures.

Comment — any comment by the user added at the signature point.
Signature time and date — the time and date of the signature point.
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Loading a Workspace

You can load an existing workspace and continue work. Only the user who created the
workspace, or an administrator, can open a workspace. If a workspace has been locked,
then users that are members of a group with Review and/or Approve permissions can
load the workspace to review or approve it.

A locked workspace is read-only. An approved workspace is also read-only. However,
login information is still recorded in the Audit Trail.

1. Select the Workspace ID of the workspace you would like to load and then click
Load Workspace.
The Load workspace dialog is displayed.

2.  Click OK to confirm.
Any unsaved data in the current workspace will be saved. If a signature is
required, the Sign workspace dialog will be displayed for you to enter a signature.
The workspace closes. Spectrum then reloads with the selected workspace
displayed.

NOTE: When a workspace is loaded, the Audit Trail displays the details of that

workspace only. To view the details of other workspaces, you must return to your

own workspace. Refer to Exiting the workspace.

Exiting the workspace

After completing work on your own workspace:

1.

Select Exit from the File menu.

OR

Click Close (X) at the top right of the Spectrum window.
The Save Options dialog is displayed.

Select Reload spectra next time.

This option saves any unsaved data, and reloads the current spectra, settings and
layout next time you login to Spectrum, which enables you to carry on with your
work from where you left off when you next login to Spectrum at this PC.

OR
Select Don't load spectra next time.
This means a new workspace loads next time you login to Spectrum.
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After completing work on another user's workspace:

1.  Select Exit from the File menu.
OR
Click Close (X) at the top right of the Spectrum window.
The Save Options dialog is displayed.

2.  Select Return to workspace to reload the previous workspace.
OR
Select Exit the software.

The previous workspace is restored next time you login to Spectrum at this PC,
Saving the Audit Trail

1.  To save the Audit Trail of the currently displayed Workspace, click Save.
A Save As dialog is displayed.
2.  Select the required destination and then enter a filename.
The Audit Trail is exported as a *.csv file that can be opened in a spread-sheeting
application, for example, Microsoft® Excel™.
Printing the Audit Trail

1. To print the Audit Trail of the currently displayed Workspace, click Print.
The Print Preview dialog is displayed.
2.  Review the printed output, and then select Print from the File menu.

Additional Information

The Spectrum ES Audit Trail is saved to the database Spectrum10ES*.mdf. A Spectrum
database has a default maximum size of 6 GB. When it reaches this size, a new database
is automatically created.

The default location of the Spectrum ES database(s) is:

o Windows XP — C:\Documents and Settings\All Users\Application
Data\PerkinElmer\Spectrum\Spectrum10ES*.mdf

OR
o Windows 7/8 — C:\ProgramData\PerkinElmer\Spectrum\Spectrum10ES*.mdf
You can also configure Spectrum ES to access the database over a network. For more

information, refer to the Spectrum ES Administrator's Guide (part number L1050100)
available on the manuals CD supplied with your software.

A new workspace may be based on the system default, or on a group default. Refer to
Assigning a New Default Workspace for more information.
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Signing

The ability to formally sign at signature points is available in Spectrum Enhanced Security
(ES) software only. Only the user that created the workspace, or a member of the
Administrators group, can sign the workspace. A user’s signature applies to the whole
workspace, and covers all currently unsigned activities logged for the user in the
Spectrum ES Audit Trail.

You will be prompted to enter an electronic signature when performing an action that
requires a signature, such as exporting data, or when you exit the software. You can also
sign the workspace at any time by selecting Sign from the Audit Trail menu.

Objects such as Equations, Macros, Instrument Setups and Sample Table Setups contain
their own Audit Trail, and are not signed as part of signing the workspace. To sign one of
these objects, select Sign from the Signatures drop-downs on the Setup Equations and
Setup Macros tabs, and the Sample Table Setups and Instrument Setups dialogs, as
applicable. Refer to the on-screen Help accessed from those dialogs for more
information.

Signing the Workspace (Audit Trail Menu)

1. Select Sign from the Audit Trail menu.

The Sign Workspace dialog is displayed. The upper part of the dialog shows the
Audit Trail. The lower part, if displayed, shows the signatures in the current
workspace. To display the Signature Details list, ensure that Show signature
details is selected.

2. To sign the workspace, click Sign.
The Sign dialog is displayed.
Enter your User name and Password.

4.  Select the appropriate pre-defined Reason from the drop-down list, if applicable.

NOTE: A reason will required if an administrator has defined Reasons on the Signatures
tab for the Workspace signature point.

Enter any Comment required.
6.  Click OK.

Additional information

Signature points are predefined and cannot be added to, but members of the
Administrators group can define which actions will require a signature. If no signature is
required, then the software will ignore the signature point and you will not be prompted
for a signature. However, if any Reasons have been set up for the signature point, you
will still be prompted to select one. Refer Signatures for more information.

A signed (and locked) workspace, or a signed object, can be reviewed and approved by
users that are members of a group with Reviewer or Approve permissions. Refer to
Reviewing and Approving for more information.




480 . Spectrum User’s Guide

Lock/Unlock Workspace (Spectrum Enhanced Security only)

When a user has completed work on a workspace, it should be presented for sign-off by
users with the required authority. The workspace must be locked to indicate that it is
ready for review and to make it visible in the Audit Trail to users with Review and/or
Approve permissions.

Only the user that created the workspace can lock or unlock the workspace.
Lock Workspace

The Lock workspace option enables the user to make a workspace available for review
and approval by users with the appropriate permissions. Lock is not available if the
workspace is already locked.

When a workspace is locked it becomes read-only. Users with Review or Approve
permissions can load the workspace and then review or approve it, but they cannot make
changes to content.
To lock a workspace:
1. Display the workspace you want to lock.
You can lock the current workspace, or load a previously saved workspace.
2.  Select Lock from the Audit Trail menu.

The Sign Workspace dialog is displayed. The upper part of the dialog shows the
Audit Trail. The lower part, if displayed, shows the signatures in the current
workspace. To display the Signature Details list, ensure that Show signature
details is selected.

3.  Click Sign.
The Sign dialog is displayed.
4.  Enter your User name and Password.
Select the appropriate pre-defined Reason from the drop-down list, if applicable.

NOTE: A reason will required if an administrator has defined Reasons on the Signatures

tab for the Workspace signature point.

6.  Enter any Comment required.
Click OK.

The workspace Status is changed to Locked. Users with Review and/or Approve
permissions can then view the workspace under For Review or For Approval in
the Audit Trail dialog. Refer to Reviewing and Approving.
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Unlock Workspace

Unlock is not available if the workspace is not locked. A workspace can be unlocked only
by the user that locked it. A workspace cannot be unlocked once it has been approved
(workspace Status Approved).

To unlock a workspace:
1.  Display the workspace you want to unlock.
2. Select Unlock from the Audit Trail menu.

The workspace Status is changed to Unlocked. The workspace is no longer visible
under For Review or For Approval in the Audit Trail.
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Reviewing and Approving Workspaces

Reviewing and approving, or returning, workspaces is a function of Spectrum Enhanced
Security (ES) software only and can be performed only by someone with the appropriate
permission(s). It is up to the administrator to set the correct privileges to ensure that
only the appropriate people can "sign-off" data.

We use the term "Review" to mean that the person has looked at the data and has
agreed that it is correct. This is along the lines of a peer review and any number of
people can review data as determined by your internal procedures.

We use the term "Approve" to mean that a person with the "authority" has signed off the
data as fit-for-purpose and, again, details of who is allowed to do this should be
documented in your internal procedures. When a workspace has been approved, it will be
read-only. You will be able to view the data but no changes can be made.

When work has been completed on a workspace, the user must lock it to indicate that it
is ready for review and/or approval. A user with Review or Approve permissions can then
load the workspace to check the data. The ability to load a workspace created by another
user means that a reviewer or approver can check the work at any time: the user does
not have to be present. If you are working over a network, a reviewer or approver can
load a workspace created by another user while that user is logged in to Spectrum ES at
another PC.

After checking the workspace, reviewers and approvers can add an electronic signature
using the Return, Review or Approve option from the Audit Trail menu. (The items
displayed will depend on the permissions of the user.) A workspace can be reviewed
multiple times, and by multiple users. A workspace can be approved without being
reviewed. However, when a workspace has been approved it will be read-only and can no
longer be reviewed. If a reviewer or approver views the data and does not agree that it is
correct, then if they have the Return Workspace permission they can "Return" the
workspace to the user with a description of the problem.

Some objects such as Equations, Macros, Instrument Setups and Sample Table Setups
contain their own Audit Trail. They are reviewed or approved separately from the
workspace using the Review or Approve option in the Signatures drop-down on the
appropriate dialog. Refer to the on-screen Help accessed from those dialogs for more
information.

Reviewing or Approving the Workspace (Audit Trail Menu)

Workspaces that have been locked by a user ready for review are visible in the Audit Trail
to users with Review or Approve permissions (assigned by default for members of the
groups Reviewers and Approvers).
To review or approve a workspace:
1. Select Audit Trail from the Audit Trail menu.
The Audit Trail dialog is displayed.
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Use the filters to display the workspace that you want to review.

Select For Review or For Approval as the Workspace selection. Then select the
Creator ID of the appropriate user from the drop-down list, or All to see
workspaces from all users.

NOTE: In the list of Workspaces the Login ID of the last user to access the
workspace will be shown. This may be the creator of the workspace, or a

reviewer.

Select the workspace, and then click Load Workspace.
Click OK to confirm that you want to load the workspace.

If you have unsigned data in your current workspace, then you are asked to sign
the workspace.

The workspace closes. Spectrum will then be reloaded with the selected
workspace displayed. The loaded workspace is read-only, although login
information will be saved to the Audit Trail.

When you have finished checking the workspace, if the contents are correct
select Review or Approve from the Audit Trail menu.

The Review Workspace or Approve Workspace dialog is displayed. The upper part
of the dialog shows the Audit Trail. The lower part, if displayed, shows the
signatures in the current workspace. To display the Signature Details list, ensure
that Show signature details is selected.

OR

When you have finished checking the data, if the data is not correct, return the
workspace to the user.

To review or approve the workspace, click Review or Approve.

The Review or Approve dialog is displayed.

Enter your User name and Password.

Select the appropriate pre-defined Reason from the drop-down list, if applicable.

NOTE: A reason will required if an administrator has defined Reasons on the Signatures
tab for the Review or Approve signature points.

Enter any Comment required.
Click OK.

If the workspace was reviewed it is still visible to users under For Review or For
Approval in the Audit Trail. A workspace can be reviewed more than once by the
same reviewer and by several reviewers. The user that created the workspace,
and the administrator, can see the workspace under Reviewed.

If the workspace was approved it is no longer visible to users under For Review
or For Approval in the Audit Trail. The user that created the workspace, and the
administrator, can see the workspace under Approved. The workspace is now
read-only.

Exit the workspace.

You can review or approve, as applicable, multiple workspaces without exiting
Spectrum software. Refer to Exiting the workspace for more information.
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Returning the Workspace

If a reviewer or approver identifies a problem with the workspace, and does not want to
review or approve the workspace until this has been corrected, then they can Return the
workspace to the user. If enabled for the Return Workspace signature point, they can
add a comment describing the problem.

Return is only available from the Audit Trail menu if the reviewer or approver has the
Return Workspace permission (assigned by default for members of the groups Reviewer
and Approver) and a locked workspace has been loaded.

1.

Select Return from the Audit Trail menu.

The Return Workspace dialog is displayed.

Enter your User name and Password.

Select the appropriate pre-defined Reason from the drop-down list, if applicable.

NOTE: A reason will required if an administrator has defined Reasons on the Signatures

tab for the Return Workspace signature point.

Enter any Comment required.
Click OK.

The workspace is no longer visible to users with Review or Approve permissions
(assigned by default for members of the groups Reviewers and Approvers) under
For Review or For Approval in the Audit Trail. The user that created the
workspace, and the administrator, can see the workspace under Returned.

Additional information

Refer to Signatures for more information about the signature points in Spectrum.
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Workspace Reference

These reference topics describe the elements of the Spectrum user interface:
Viewing Area
Data Explorer
Navigation Pane

Dialog Pane

Menus

Toolbars

Additional Information
. The View menu includes options that enable you to select whether a toolbar is

shown or hidden.

. For information about manipulating toolbars and resetting the workspace layout,
see Showing, Hiding and Moving Toolbars.

o For information about manipulating toolbar buttons, see Personalizing Toolbars.

. You cannot customize the Status bar.
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Viewing Area

The Viewing Area contains one or more tabs, depending on the item you have selected in
the Data Explorer, whether an instrument is connected, and whether or not the
instrument is scanning.

Additional tabs may be displayed showing the results of some processes: Search,
Compare, Quant and Peak Table.

Offline

Item Selected Tab

[Samples View name] Graph tab [Samples View name]

Results Table tab

[spectrum name] Graph tab [spectrum name]

History tab

Instrument Connected

Not Scanning

Item Selected Tab

Sample Table Sample Table

[Samples View name] Graph tab [Samples View name]

Results Table tab

[spectrum name] Graph tab [spectrum name]

History tab
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Scanning
Item Selected Tab Option
[Samples View name] Live tab Energy
Sample
Single Beam

Interferogram

Force Gauge

Graph tab [Samples View name]

Results Table tab
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Graph Tab

When you are viewing a single spectrum, the Graph tab displays the curve and a Results
pane.

When you are viewing a Samples View selected using the Data Explorer, the graph tab
contains a table (or 'spectrum browser') that enables you to select which curves you
want to display from that Samples View.

Additional Information
Optimizing and Formatting Graphs

o To learn more about optimizing graphs, and preparing them for publication by
formatting and adding labels, see Viewing Spectra.

o The Results pane includes columns for the Name (ID), Description, an icon to
indicate whether the curve has been saved, and an icon to indicate whether any
warnings were generated by Quality Checks.

A column chooser in the top left corner enables you to select which columns are
displayed. You can also resize any column by dragging it borders, or move a
column by dragging its header.
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History Tab

Use the History tab to view information about the way in which a spectrum was collected
and, if applicable, was processed.
When the spectrum is saved, this information is stored in the file header.
1. Select the spectrum in the Data Explorer Pane.
The spectrum is displayed in the Viewing Area.
2. Select the History tab.

Information about the spectrum is displayed categorized by Sample, Instrument,
History, and Quality Checks.

The fields displayed depend on your instrument configuration and the amount of
processing that has been applied to the spectrum.

Additional Information

When exporting your data using the Custom Defined Format, include the information
displayed on the History tab in the header of the exported file using the Header Options
on the Setup Export tab.

Amending the Sample History

The information in the History tab is collected automatically and cannot be edited, or was
entered in the sample table as the spectrum was collected.

You can, however, amend the current Sample Description and Comment using the Status
dialog:
1. Select the Graph tab.
2.  Place the mouse pointer over the curve, right-click, and then select Status.
The Status dialog opens with the Sample tab displayed.
The Status dialog includes a useful subset of the History information.
Edit the Description and Comments fields as required.
4,  Close the Status dialog.
To update the History tab, save, close and then reload the spectrum.
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Results Table Tab

To view a table that summarizes all the spectra in the currently selected Samples View:
»  Select the Results Table tab.

The Results Table includes a row for each spectrum in the Samples View, and
columns for the Name (ID), Description, an icon to indicate whether the curve
has been saved, and an icon to indicate whether any warnings were generated by
Quality Checks.

If the Results Table becomes overly complex, consider hiding (or resizing) the columns
containing intermediate results:

>  To select which columns are displayed, use the column chooser in the top left of
the table.

>  To resize a column, drag its borders.
>  To move a column, select and drag its header.

You can delete an Equation result column from the Results Table in Standard software:

>  To delete an Equation result column, right click the mouse button in the column
and then select Delete from the shortcut menu.

Processes and Equation Results

o If you apply a process to a spectrum that generates a new spectrum, the new
spectrum is appended to the Samples View, and a new row is added to the
Results Table.

. If you apply a process to a spectrum that generates a numeric result, such as an
Equation, a new column is added to the Results Table, and the result is entered
into the corresponding cell.

Search

. The full list of best hits, ranked by score, is displayed in the Search tab.

. By default, the highest scoring result is displayed in a set of columns in the
Results Table.

o If you apply a Search process to more than one spectrum, the Results Table
includes a row for each spectrum, and the highest scoring result for each
spectrum is recorded in the corresponding cells in the Search columns.

o If you apply another Search process to a spectrum, another row is created in the
Search tab, and another set of Search columns is created in the Results Table.

If you decide that the highest scoring best-hit for a sample is inappropriate, you can
accept another hit:

1.  Select the Search tab, and then make sure the appropriate row is selected in the
Source Spectra Search Results table.

When a Samples View is selected, the Source Spectra Search Results table in the
Search tab refers to every sample in the Samples View. If you select a sample
from the Samples View, the Search tab refers to the selected sample.

2. Select your preferred row from the List of Searched Library References table, and
then click Accept as best hit.

The corresponding search result cells in the Results Table tab are updated to
refer to the accepted result.
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You can also delete all the Search results for a particular sample:

1.

Select the Search tab, and then make sure the appropriate row is selected in the
Source Spectra Search Results table.

Right-click in the Source Spectra Search Results table, and then select Delete
Selected Result from the shortcut menu.

The corresponding search result cells in the Results Table tab are updated.

Macros Results

For a Macro, the Samples View and Results Table are updated as each process in
the chain is completed.

This enables you to examine all the intermediate spectra and results.

Processes such as Smooth, which you can set to overwrite the source spectrum
when used alone, cannot be set to overwrite the source spectrum when used
within @ Macro. However, for spectra, or results, generated during a macros step
to be added to the Samples View and displayed in the Viewing Area, or the
Results Table, Visible should be enabled for the macro step in the Macro
Settings dialog.

If you apply a Macro to more than one spectrum, the Macro is applied step-by-
step to each spectrum.

Quant Results

The Results table lists the Sample Name, the Method Name, and any results
associated with the Method, such as the Total M-distance.

You can select which columns to display in the table using the column selector in
its top left corner.

Your Quant results for each Spectrum are also tabulated in the upper left
quadrant of the Quant tab.

The full details for each result are displayed in the top right quadrant Quant tab.

If you apply another Quant process to a spectrum, another row is created in the
Quant tab, and another set of Quant columns is created in the Results Table.

Repeat Collections (Raman Only)

If you have one or more repeat collections selected on the Setup Instrument Data tab,
one sample in the Sample Table will generate a number of rows in the Results Table,
each with [_nnn] appended to the original Sample ID.
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Live Tab

While Scanning

By default, the Live tab is displayed during scanning to provide a progress monitor. When
the spectrum is complete, the Graph tab is displayed.

If you are connected to a Raman instrument, the upper toolbar provides the progress of
the current measurement (%). The lower progress bar provides the overall progress of
the data collection, which might consist of a several markers, or a number of repeat
collections; for example, scan 1 of 3.

If you do not want the Live tab to be displayed during scanning, deselect (uncheck) the
Show live display option in the Instrument Setup dialog.

While Monitoring
The Live tab is used to display a range of monitoring tools.
While Previewing

When the Preview option is selected on the Sample Table, the Live tab is displayed to
help you monitor the scan conditions before initiating data collection. This is useful with
accessories such as the Universal ATR and the HATR, where a Force Gauge is enables
you to achieve optimum transmission and minimize any risk of crystal breakage. It is also
useful for Raman data collection where the Exposure time and Laser power may need to
be adjusted.
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Sample Table

Use the Sample Table tab to specify the Sample IDs and Descriptions for a batch of
similar samples.

The Sample Table is available whenever an instrument is connected. You cannot build a
Sample Table when working offline.

Displaying the Sample Table

>  Select Sample Table from the Measurement menu.
OR
Open the Data Explorer pane, and then select Sample Table.
The Sample Table is displayed in the Viewing Area.

Save Location

This field displays the current default path to saved spectra.

»  To amend this default path, click [:], browse to and select your preferred
location, and then click OK.

The Save Location on the Setup Instrument Data Collection tab is also updated.

NOTE: In Spectrum ES if you do not have the appropriate permission, then you will not
be able to modify the Save Location.

Preview

The Preview option initiates the monitor mode for the sample, which helps you optimize
the scan conditions before initiating data collection. This is useful with accessories such
as the Universal ATR and the HATR, where the force applied to the sample by the
pressure arm can be important, or for Raman data collection where the Exposure time
and Laser power may need to be adjusted.

1. Select the Preview option and then select Scan from the Measurement menu, or
click b .

Data collection is monitored in the Live tab while you prepare the sample, or
make adjustments.

2. When you are happy with your setup, click b .
The sample is scanned.

Sample ID and Description

The Sample ID and Description fields in the Instrument Settings bar correspond to the
first 'unmeasured' row in the Sample Table.

Any default entries in the Sample ID and Description fields rows depend on the Setup
Instrument Auto-Name settings.

>  To amend a Sample ID or Description, double-click the field and enter new text.

To avoid replacing all the text, click to place your editing cursor within the
highlighted text.
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Right-click to select Copy (CTRL+C) and Paste (CTRL+V) commands.
You cannot use a Sample ID more than once. Any duplicate entries are
highlighted in pink and data collection from this sample will not be executed.

Sample Rows

By default, the Sample Table contains a row for each completed measurement, and
another row for the next measurement.

To set up a batch of samples, build a table with the appropriate number of 'unmeasured'
rows.

Selecting Rows

>  Select, or deselect, a complete row in the Sample Table by clicking the first
(leftmost) column in the row. The most recently modified row is marked, and any
selected rows (or cells) are highlighted.

To select a block of rows, hold down SHIFT and click the first and the last cells in
the block, or drag a highlight up or down the table.

To select or deselect a row, leaving the others selected, hold down CTRL as you
click the rows.

Adding Rows

To add a number of rows to the bottom of the Sample Table:
1.  Enter the number of rows to be added.
2. Click Add.
OR
Right-click anywhere within the table and then select Add.

NOTE: If you have Spectrum ES, you will not be able to add rows to the Sample Table if
you do not have the appropriate permissions.

Moving and Inserting Rows

Move rows to amend the order in which the samples are measured. Insert a row to place
a sample in a particular position in the batch.

>  Select the unmeasured rows you want to move, and then click Up or Down (or
right-click and select Up or Down).

>  Toinsert a new row above the selected row, click Insert (or right-click and select
Insert).

Removing and Clearing Rows

You may want to clean up the Sample Table so that it only refers to the current batch of
samples.

>  Select any rows that are not needed and then click Remove.

>  To remove all the rows for completed measurements, click Clear Measured.

NOTE: Removing or Clearing rows in the Sample Table does not affect the Samples
Views and links set up in the Data Explorer.
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Custom Columns

Selecting Columns

>

Select, or deselect, a complete column in the Sample Table by clicking the column
title bar. Any selected columns are highlighted.

To select a block of columns, hold down SHIFT and click the first and the last
column titles in the block, or drag a highlight left or right across the table.

To select or deselect a column, leaving the others selected, hold down CTRL as
you click the columns.

Adding Columns

NOTE: If you have Spectrum ES, you will not be able to add columns to the Sample

Table if you do not have the appropriate permissions.

To add a column to the Sample Table:

1.

Click Add Column.

OR

Right-click any column title and then select Insert Column.
The Add a custom column dialog is displayed.

Enter a title for the column in the Name field.

The column name cannot be blank. An existing column name cannot be used. All-
numeric column titles are not allowed.

Select the Type of custom column, and define any settings for that type.
The options are Data Entry, File Path, Numeric, List or Image.

Data Entry custom columns allow both numeric and text entries if you select
Text. If you have a barcode reader and you wish to enter barcodes in this
column, select Barcode. You can then optionally enter a Barcode Prefix that
will filter which barcodes are entered in the column. For more details, see
Barcode Reader.

File Path custom columns allow the user to select a spectrum from disk that can
then be used in a processing step, such as Arithmetic.

List custom columns allow you to create a list of options for the user. Only items
within the list can be selected in the Sample Table column. Add new entries to
the List using the Add button on the Add a custom column dialog. Change the
order of the list using the Up and Down buttons. To delete an entry from the
list, highlight the item and click Remove.

Numeric custom columns can be set to display a number of Decimal places or
Significant figures. Only numeric entries are allowed in the column.

Image custom columns contain a browse button that allows you to navigate to an
image. *.bmp, *.jpg and *.gif files can be opened.

If you wish to force users to complete a column entry before running a sample,
select Mandatory.

Click OK.

The Sample Table will be updated to include the column you have added. Any
Mandatory entries will be highlighted in red until data is entered. If you try to run
a sample row containing fields highlighted in red, the scan will not be completed
and a warning message will be displayed.
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Moving and Inserting Columns

Move columns to amend the order in which the data is displayed.

>  Select the column you want to move, and then click and drag the column. The
new location is indicated by arrows.

>  Toinsert a new column to the left of the selected column, right-click and select
Insert Column.

Editing custom columns

1. Right-click the title of the column you wish to modify and select Edit Column.
The Edit custom columns dialog is displayed.
2. Torename to column, select Edit Name and edit the Name field.
3.  To change the Type, select a new option from the drop-down list.
If you select a new type, any data you have entered in the column will be lost.
4.  Click OK.

Making Custom Columns Read only

After you have entered data in a custom column, you can make that data read only.
1. Right-click the title of the column you wish to modify and select Edit Column.
The Edit custom columns dialog is displayed.
2.  Select Read only.
3.  Click OK.
The entries in the column in the Sample Table now cannot be edited.

Setups

You can save the Sample Table, or load a previously saved Sample Table. To access the
Sample Table Setups dialog, click Setups.

The Sample Table Setups dialog contains a list of Sample Table settings that have been
saved. To save the current Sample Table as a setup, click Save current Sample Table.
You can select a previously saved Sample Table and make this the current Sample Table
using Set as Current. To delete a Sample Table setup, click select the appropriate row
in the table and then click Delete.

The Sample Table setups list is specific to the User currently logged in to Spectrum. You
can Export your Sample Table Setup (as a *.smt file, or secured *.ssmt file) or Import
an existing file.

Sample Table setups can also be loaded and used as part of a Macro.

NOTE: The setups in the Common Sample Table Setups Directory will be visible to all
users. The Common Sample Table Setups Directory is defined at Spectrum
installation. The default is C:\pel_data\SampleTableSetups
In Spectrum ES, Sample Table Setups in the Common Sample Table Setups
Directory are added to the Sample Table Setups dialog each time a new user

workspace is created.
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Signing, Reviewing or Approving a Sample Table Setup (Spectrum ES only)

To Sign a Sample Table Setup:

1. Select the row containing the Sample Table Setup you want to sign for and then
select Sign from the Signatures drop-down list.

The Sign Sample Table Setup dialog is displayed. This contains the Audit Trail
entries for that Sample Table Setup, and any signatures added previously.

2.  To sign the Sample Table Setup, click Sign.
The Sign dialog is displayed.
Enter your User name and Password.
4.  Select the appropriate pre-defined Reason from the drop-down list, if applicable.

NOTE: A reason will required if an administrator has defined Reasons on the Signatures
tab for the Sample Table Setup signature point.

Enter any Comment required.

Click OK.

The Sign Sample Table Setup entry is added to the Sample Table Setup Audit
Trail.

The Sample Table Setup can now be exported for review or approval by a user with the
appropriate permissions.

To Review or Approve a Sample Table Setup:

Users with the appropriate permissions can import a signed Sample Table Setup to
review or approve it. The options Review and Approve then become available from the
Signatures drop-down list. A Sample Table Setup can be signed or reviewed more than
once, and by more than one reviewer. A Sample Table Setup can be approved without
being reviewed, but once it has been approved it becomes read-only and can no longer
be reviewed or edited.

1. Select the row containing the Sample Table Setup you want to review or approve,
and then select Review or Approve from the Signatures drop-down list.

The Review Sample Table Setup or Approve Sample Table Setup dialog is
displayed. This contains the Audit Trail entries for that Sample Table Setup, and
any signatures added previously.

2.  To review or approve the workspace, click Review or Approve.
The Review or Approve dialog is displayed.
Enter your User name and Password.
4,  Select the appropriate pre-defined Reason from the drop-down list, if applicable.

NOTE: A reason will required if an administrator has defined Reasons on the Signatures

tab for the Review or Approve signature points.

Enter any Comment required.
6.  Click OK.

The Review Sample Table Setup or Approve Sample Table Setup entry is added
to the Sample Table Setup Audit.

The Sample Table Setup can now be exported for review or approval by another user, if
it has not been approved, or to be added to a group default workspace by an
administrator.
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Import CSV

You can import a CSV file containing sample information into the Sample Table.

1.

Ensure that the Sample Table setup displayed contains the appropriate columns
for the samples you wish to add.

The CSV file import will enter data into the columns defined on the Sample Table.
It will not create new columns, or reorder existing columns.

Create a CSV that contains the data you wish to import into the Sample Table.

It is advisable to produce a test CSV file to check that the columns are set up
correctly, before importing a lot of sample data.

The CSV file should contain entries that correspond to the columns in the Sample
Table setup, in the correct order. You will need to include empty columns as a
placeholders for any Image custom columns. Any data entered in this column will
not be imported into the Image column.

You should not include placeholders for the leftmost column that indicates
whether a measurement has been completed, the column that indicates whether
the curve has been saved or the column that indicates whether any warnings
were generated by Quality Checks.

If you include any text that will be entered into a List custom column but that
does not match one of the predefined entries, the field will be left blank when the
CSV file is imported. If you include any text that will be entered into a Numeric
custom column, the field will be left blank. Only numeric entries can be imported
into a Numeric custom column.

If you want to include entries in your CSV file that contain a comma, you can put
the entry in quotation marks. For example, "2,00","1,00".

Any blank rows in the CSV file will be ignored when the file is imported.
Click Import CSV.

The Import CSV dialog is displayed.

Browse to and select the *.CSV file you wish to import and then click Open.

Click Yes. to overwrite the existing samples in the Table with those in the *.CSV
file.

OR
Click No to cancel the import.

Additional Information

The Sample IDs entered in Sample Table are used in the Prompts Display, which
is included in the Measurements bar by default. The Prompts Display is analogous
to the instrument display on some spectrometers.

By default, the Sample Table includes columns to indicate that a measurement
has been completed, Sample (ID), Description, an icon to indicate whether the
curve has been saved, and an icon to indicate whether any warnings were
generated by Quality Checks.

A field chooser in the top left corner enables you to select which columns are
displayed in the table. You can also resize any column by dragging its borders, or
move a column by dragging its header.

Custom column entries are available as Variables on the Equations tab.

Data entered for samples that have not been scanned, including custom column
entries, will only be retained upon exiting and reopening the software if you
select Save for reload next time on the Save Options dialog before closing the
software.
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. If Enable Pathlength is selected on the Setup Pathlength tab, a column
Pathlength (mm) will be added to the Sample Table. See Setup Pathlength for
more information.

Raman Instrument

If you are connected to a Raman instrument with a motorized stage you can set up two
types of data collection. You can add samples to the Sample Table for "point-and-shoot
measurements”, where you select a region of your sample, set up the measurement
parameters and then click Scan to collect data at the current stage location. Or you can
use the controls on the Setup Sample Area XYZ Stage or Setup Microscope XYZ Stage
tabs to set up multiple-location data collections using, for example, Markers, Maps and
Line Scans.

Objects added to the Setup XYZ Stage tabs are not included in the Sample Table, and will
be scanned in preference to any samples added the Sample table. For more information

see Setup XYZ Stage tab.

If you are connected to a Raman instrument with a motorized stage and collecting data
using the Sample Table, any Sample Pattern selection made on the Setup XYZ Stage tab
will still apply.

Barcode Reader

You can use a barcode reader to enter data into the Sample Table. In standard
operation, each barcode will be entered into the next empty cell in the column of the
Sample Table, just like typing in a cell and pressing the ENTER key.

You can configure your PerkinElmer supplied barcode reader (part number L9004196) to
only enter barcode data into Data Entry custom columns set to Barcode data entry. If
you enter a Barcode Prefix, only barcodes with that prefix will be entered into the
column. To configure the barcode reader you will need to scan a sequence of barcodes
as described in the hard-copy leaflet (part number L1050245) that was supplied with you
barcode reader.

You could, for example, define a custom column for the Part Number of a material with
the prefix LX, for the Supplier ID with the prefix Z, and for the Lot number with the
prefix 9. When you scan a number of barcodes in succession, Spectrum will determine
whether each input is a barcode, check the prefix and then enter the barcode in the next
empty cell in the appropriate column. For example, any barcode beginning LX will be
entered into the first available cell in the Part Number column.

NOTE: You can also set up the Sample ID and Description auto-name placeholders as
barcodes on the Setup Instrument Auto-Name tab for PerkinElmer FT-IR

instruments or the Setup Instrument Auto-Name tab for PerkinElmer Raman

instruments.
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Peak Table Tab

When you run a Peak Table or Peak Area/Height process, the results are displayed on the
Peak Table tab.

The upper left quadrant of the Peak Table tab lists each spectrum.

You can select which columns to display in the table using the column selector in
its top left corner.

To view this table in detail, it may be helpful to drag the borders between the
quadrants.

The List of Peaks for each spectrum is tabulated in the upper right quadrant of
the Peak Table tab.

You can select which columns to display in the table using the column selector in
its top left corner.

To view this table in detail, it may be helpful to drag the borders between the
quadrants.

Your source spectrum or spectra are displayed in a graph below the results tables
with the peak X and Y positions labeled.

The peak areas will be shaded and the height will be marked on the peaks if a
Peak Area/Height process was run.

Use the shortcut menu to Copy the Peak Table to the clipboard, or use the Send
To command to copy the contents of the Viewing Area into a Word or WordPad
document.
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The Data Explorer

Use the Data Explorer together with the Viewing Area to organize your sample data in
the Spectrum workspace.

e The Data Explorer pane is on the left of the Spectrum workspace.

It contains Samples Views and links that help you organize the spectra that you
open, collect, process, or publish.

NOTE: Samples Views are virtual folders that are a useful way to organize your spectra in
the Spectrum Workspace. They have no explicit relationship with where, or whether,
spectra are saved.

e If you have Spectrum ES, the Data Explorer will also contain a Recycle Bin. Any
spectra that are deleted from a Samples View will be stored in the Recycle Bin.

e When you are connected to an instrument, the Data Explorer also enables you to
open the Sample Table, which you use to set up data collection from a batch of
samples.

e If you are connected to a Spotlight 200 microscope, the Data Explorer also
includes a Microscope option that displays the Camera View and Stage View. If
you have scanned a series of markers in an image, then the Data Explorer
includes an Image View (similar to a Samples View) that contains the image,
spectra and results tables.

e The Viewing Area is in the center of the Spectrum workspace.

The contents of the Viewing Area, arranged on one or more tabs, reflect the
Samples View or spectrum selected in the Viewing Area.

This organization is preserved when you Exit Spectrum provided that you choose to Save
for reload next time.

Working with Samples Views
Creating a New Samples View

# Select New from the File menu.
Adding a Saved Spectrum in a Samples View

1. Select the Samples View, right-click, and then select Open spectrum.
The Open File dialog is displayed.
2. Browse to, and select, the spectrum you want, and then click Open.

Renaming a Samples View

1. Select the Samples View, right-click, and then select Rename.
The Rename Samples View dialog is displayed.
2. Enter a valid name, and then click OK.
If the name is not valid, an advisory message is displayed in the dialog.
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Deleting a Samples View

* Select the Samples View, right-click, and then select Delete.

The Samples View, and any links it contains, are deleted from the Data Explorer.
Any saved spectra are not deleted from disk.

NOTE: If you have Spectrum ES, you may be prompted to enter an electronic signature for
the Delete Graph signature point. The contents of the Samples View will be stored in
the Recycle Bin.

Working with Sample Links
Creating New Links

New links are added automatically as you collect, open and process spectra. The contents
of a Samples View reflect the work you have done on this sample.

Copying a Link into a New Samples View
» Select the link, right-click, and then select Copy to New Folder.
Renaming a Sample

1. Select the link, right-click, and then select Rename.
The Rename Sample dialog is displayed.
2. Enter a valid name, and then click OK.
If the name is not valid, an advisory message is displayed in the dialog.

Deleting a Link

* Select the link, right-click, and then select Delete.

The link is deleted from the Data Explorer. If saved, the spectrum is not deleted
from disk.

NOTE: If you have Spectrum ES, you may be prompted to enter an electronic signature for
the Delete Graph signature point. The contents of the Samples View will be stored in
the Recycle Bin.

Copying a Link from one Samples View into Another

» Select the link, and drag it to the Samples View you want to copy to.

If a link of the same name already exists in the Samples View, a suffix is added
to the new link name.
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Working with the Recycle Bin (Spectrum ES only)
Restoring a Sample

» Right-click on the sample link in the Recycle Bin and then select Restore.
The sample link is restored in the Samples View. If the Samples View had been
deleted previously, it is recreated and the samples link added.
Restoring Samples Views
% Right-click on the Recycle Bin in the Data Explorer pane and then select Restore
AllL

Any Samples Views in the Recycle Bin will be recreated in the Data Explorer,
together with any spectra they contained.

NOTE: If you have Spectrum ES, the contents of the Samples View will be added to the
Recycle Bin.

Repeat Collections (Raman Instruments Only)

If you select Repeat Collections on the Setup Instrument Data Collection tab, for each
sample scanned Spectrum will perform the number of repeat scans specified. The spectra
are grouped in a Samples View named [Sample ID] where the Sample ID is from the
Sample Table. The file name of each spectrum is the Sample ID with a humber _nnn
appended corresponding to each repeat collection. For example, [Sample ID]_[nnn].sp.

NOTE: You can only run one repeat collection at a time. You cannot run repeat collections of shapes
added to the Setup Sample Area XYZ tab or Setup Microscope XYZ tab, such as markers,
maps and line scans. If there are any shapes that have not been run, you will not be able to
start a Repeat Collection until they have been measured or deleted.

Cell Markers and Markers (Raman Instruments Only)

The spectra for each marker scanned will be added to a new Samples View, named
Markers nnn. Each spectrum is called [Sample Name].sp using the Sample Name
specified in the Marker Settings on the Setup Sample Area XYZ Stage tab or Setup
Microscope XYZ Stage tab.

The spectra for each cell marker scanned will be added to a new Samples View named
[Base Sample ID], as specified in the Cell Marker Settings on the Setup Sample Area XYZ
Stage tab or Setup Microscope XYZ Stage tab. The Base Sample Name is the file name
under which the spectrum for each cell marker will be saved with a number representing
the position in the well plate appended. For example, [Base Sample
ID]_[Row][Column].sp.

If the Base Sample ID has already been used, a number _rnnnis appended to give the
spectrum a unique file name. For example [Base Sample Name]_A2_001.sp.
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Line Scans and Maps (Raman Instruments Only)

The spectra for each line scan or map will be added to a new Samples View named [Base
Sample Name], as specified in the Line Scan Settings or Map Settings on the Setup
Sample Area XYZ Stage tab or Setup Microscope XYZ Stage tab.

The Base Sample Name is the file name under which each spectrum in the line scan will
be saved with a number representing the position in the line appended. For example,
[Base Sample Name]_(2).sp for position 2 of a line scan, or [Base Sample
Name]_(1)(3).sp for row 1 column 3 of a map.

If the Base Sample Name has already been used, a number _nnnis appended to give the
spectrum a unique file name. For example [Base Sample Name]_(2)_001.sp.

NOTE: Spectra for line scans and maps will only be added to a Samples View if you selected

Display in graph in the Line Scan Settings or Map Settings on the Setup Sample Area XYZ
Stage tab or Setup Microscope XYZ Stage tab. If your line scan or map will generate more
than 200 spectra, you will not be able to select this option.

Additional Information

Opening and Closing Panes

-

B

kg

To open or close the Data Explorer, click the button at the center of the left edge
of the Viewing Area.

OR
Select Dialog Pane from the View menu.

To open or close the Navigation pane, click the button at the center of the right
edge of the Viewing Area.

OR
Select Data Explorer from the View menu.

To open or close the Data Explorer, Navigation and Task Dialog panes
simultaneously, hold down the SHIFT key and click the button that opens or
closes any of these panes.

Resizing Panes

# Open the pane, and then drag the edge of the pane containing the button (not

the button itself) to the width or height required.
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The Navigation Pane

Use the Navigation Pane together with the Dialog Pane to, for example, set up your
instrument.

. The Navigation Pane is on the right of the Spectrum workspace.
The Setup section includes shortcuts to key items from the Setup menu.

The Spectral Libraries section includes shortcuts to the spectral libraries and files
currently included on the Setup Spectral Libraries tab.

The Equations section includes shortcuts to the Equations currently listed on the
Setup Equations tab. Selecting an Equation in the pane displays the settings of
that equation, which can be edited.

. The Dialog Pane is at the bottom of the Spectrum workspace.

The contents of the Dialog Pane, arranged on one or more tabs, reflect the
shortcut selected in the Navigation Pane.

NOTE: To see a dialog, you may have to resize the Dialog Pane.

Additional Information
Opening and Closing Panes

>  To open or close the Dialog Pane, click the button at the center of the bottom
edge of the Viewing Area.

OR
Select Dialog Pane from the View menu.

>  To open or close the Navigation pane, click the button at the center of the right
edge of the Viewing Area.

OR
Select Navigation Pane from the View menu.

>  To open or close the Data Explorer, Navigation and Task Dialog panes
simultaneously, hold down the SHIFT key and click the button that opens or
closes any of these panes.

Resizing Panes

>  Open the pane, and then drag the edge of the pane containing the button (not
the button itself) to the width or height required.
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Navigation Pane - Setup

Click Setup in the Navigation Pane to display shortcuts to key items from the Setup
menu.

> Click to set up your Instrument.
This shortcut is not available when you are working offline.
OR

A ‘T— =
>  Click :', or to set up your Raman Instrument.

This shortcut is not available when you are working offline.

OR
>  Click =8 to set up your Spotlight 200 microscope.
This shortcut is not available when you are working offline.
OR
[
>  Click to set up Ready Checks.
This shortcut is not available when you are working offline.
OR

i

»  Click to set up Instrument Verification.

This shortcut is not available when you are working offline.

>  Click I 4=l to set up the Laboratory Scheduler.

This shortcut is not available when you are working offline.

l?

>  Click — 1= to set up the Export and Email functions.

> Click 5 to set up Peak Detection.
OR

>  Click m to set up the default display options for the graph View.
OR
”H
>  Click " = to set up a global Pathlength.
OR
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gy
Click to set up the Compare function.

OR

Click to define or edit an Equation.
OR

Click to set up Spectral Libraries and Search Parameters (including
MultiSearch).

OR

.
Click to set up the Biodiesel process.
OR

Click E to set up the Verify process.
OR

AED
Click to set up the Adulterant Screen process.

OR

AY o
Click to set up the Quant process.
OR

7 4
Click to define or edit a Macro.

After you click a shortcut, the Dialog Pane at the bottom of the Spectrum workspace, is
opened (or updated) to display one or more tabs appropriate for the setup task.

NOTE: To see a dialog, you may have to resize the Dialog Pane.

Additional Information

Changing the Order of the Options in the Navigation Pane

>

To change the order of items in the Navigation Pane, click the icon you want to
move using the left mouse button, and then drag it to the new position.

Opening and Closing Panes

>

To open or close the Dialog Pane, click the button at the center of the bottom
edge of the Viewing Area.

OR
Select Dialog Pane from the View menu.

To open or close the Navigation pane, click the button at the center of the right
edge of the Viewing Area.

OR
Select Navigation Pane from the View menu.
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>  To open or close the Data Explorer, Navigation and Task Dialog panes

simultaneously, hold down the SHIFT key and click the button that opens or
closes any of these panes.

Resizing Panes

>  Open the pane, and then drag the edge of the pane containing the button (not
the button itself) to the width or height required.
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Navigation Pane - Spectral Libraries

Spectral Libraries contain the reference spectra utilized by the Search process.

# Click Spectral Libraries in the Navigation pane to display shortcuts to the
spectral libraries that have been set up in the Spectral Libraries Table.

NOTE: The Search process utilizes the spectral libraries that you Include in the Search
setup, which need not be every Spectral Library shown in the Spectral Libraries

section of the Navigation Pane.

The type of library (user-defined or commercial), and its location (local or networked),
are indicated by the link icon.

o A user-defined spectral library is a folder containing a number of reference
spectra.

o A commercial library is often a single file that includes many reference spectra
(that is, a database).

The Spectral Library Icons

»  Click % to access a user-defined library stored in a local folder.
OR

>  Click to access a user-defined library stored or shared on the network.
0

R
>  Click l._-z' to access a commercial library stored locally.
OR

-

Click i to access a commercial library stored or shared on the network.

Y
[

The Dialog Pane at the bottom of the Spectrum workspace, is opened (or
updated) to display the library browser.

NOTE: To see a dialog, you may have to resize the Dialog Pane.

NOTE: You can add spectra to an unprotected library by dragging and dropping spectra
from a Samples View or Graph onto the library icon or into the Library Pane.

The Library Browser

The library browser is displayed in the Dialog pane after you click on a shortcut in the
Spectral Libraries section of the Navigation pane. Use the library browser to browse, or to
search the textural information within, the selected spectral library.

Library Pane

The left pane lists all the spectra in the library.

>  Click Elview to select how the spectra in the library are represented in this
pane.
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Select from Details, Icons, List, or Thumbnails.

In the Details view, to sort the library in ascending, or descending, order by any
column, click in the column heading. The columns displayed in the Details view
are Name and Description. You can also display the Size, Type, Date
Created, Date Modified and any custom fields in the library. The icon in the
top left corner of the list enables you to select which columns are displayed.

Additional Properties Pane

The right pane, which is open by default, lists any Property information associated with a
particular spectrum, such as one or more physical properties (melting point,
concentration of a component), CAS number, or image of a structural unit.
If no Property information is available, you can close this pane.
> Click EEladditional Info to open, or to close, the properties pane.
To sort the library in ascending, or descending, order by Property or
Information, click in the column heading.
Find Tools
Use the Find tools to search the textural information associated with the spectra in the
spectral library, including any textural properties information.
1. Enter the text you want to search for in the Find Text field.

For example, you could enter a CAS number (provided that property has been
added to the library).

The ﬁFind button is enabled.
2. If necessary, to filter your search, select one of the Find Options.

You can select from All searchable fields, Name, Size, Type, Date Created,
and Date Modified.

3. Click #Find.

The Library pane is updated to list only those spectra that include the specified
text.

The F:}Clear button is enabled, and the . o Find button disabled.

To clear the Search:
> Click Gclear.
The Library pane is updated to list the complete spectral library.

The Find Text field is cleared, and the . i_']Find and “>'Clear buttons are
disabled.



512 . Spectrum User’s Guide

Shortcut Menu

To display the shortcut menu for a particular spectral library, right-click on its icon in the
Spectral Libraries area of the Navigation pane.

2 Remove Deletes the spectral library icon from the Spectral Libraries area,
Library and removes the library from the Setup Spectral Libraries tab. No

files are deleted.

#: Administer Opens the Library Editor.
Library

The Library Editor

Use the Library Editor to review the spectral library in detail.

For a user-defined library, you can also add or remove spectra, and define and amend
Additional Properties, such as physical properties for the sample material.

To display the Library Editor:
>  Click ®Administer in the Library browser.
OR

Right-click on the Spectral Library in the Spectral Libraries area of the Navigation
pane, and then select ¥ Administer Library from the shortcut menu.

The Library Editor is displayed.
Library Content tab

The Library Content tab lists the spectra in the library, provides a dynamic preview of the
currently selected spectrum, and lists the Peak Positions for that spectrum. Hover over a
particular peak in the preview to display its position in a pop-up label.

The columns in the Library Contents list include Name, Size, Type, Date Created, and
Date Modified. The icon in the top left corner of the list enables you to select which
columns are displayed.

You can sort in ascending, or descending, order by any column by clicking the column
heading.

You can zoom and label the preview of the selected spectrum using the graph tools
provided. However, any annotations are lost when the Library Editor is closed.

Summary tab

As well as providing some summary information about the library, and a the path to its
Location, the Summary tab enables you to edit the library Name and Description, and
to select whether to Write protect the library.
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Adding a spectrum to the library

i1,

- Add Entry.

1. Click
OR
Select Add Entry from the Edit menu.

A browse dialog is displayed.
2. Select the spectrum you want to add to the library and then click Open.

Removing a spectrum from the library

1. Select the spectrum on the Library Content tab.

2. Click 2§ Remove.
OR
Select Remove from the Edit menu.

Additional Properties

If any Additional Properties have been defined (such as one or more physical properties,
the CAS number, or an image of a structural unit), an additional column is defined for
each property in the Library Content tab

By default, the column is displayed, but can be displayed or hidden using the column
selector in the top left corner of the list.
To add a Property column:

1. Select the spectrum on the Library Content tab.

2. Click Add Property.

OR
Select Add Property from the Edit menu.
Complete the Add Property dialog.

4.  Click OK.

To amend a Property entry:

>  Double-click in the appropriate cell, complete the Enter data dialog, and then
click OK.

You can enter property data as text, or browse to a suitable image file.

To remove a Property column:
1.  Double-click the column header to select the column.
2. Click X Remove.
OR
Select Remove from the Edit menu.
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Updating the Library

If the library content has been amended outside Spectrum by, for example, adding or
deleting spectrum files, synchronize the library content with the index file created when
you defined the folder as a spectral library.

To synchronize the Library:

1. Make sure the Write Protected check box for the library on the Setup Spectral
Libraries tab is not selected.

2.  Click Update in the Library Editor.
Print and Print Preview

To print a graph containing information about one or more spectra in the Library:

1.  Select the spectrum or spectra that you want to print in the table on the Library
Content tab.

To select more than one row in the table, select while pressing SHIFT or CTRL.

Use the column selector at the top left of the table to show or hide the
information you want printed.

2. Check that the report will be printed as you intend by clicking B3Print Preview
(or selecting Print Preview from the File menu).

3. In either the Library Editor or the Print Preview window, click 5Print.
OR
Select Print from the File menu.

A report containing the graph is printed, with the data displayed in the
corresponding row in the Library Content tab appended. If you selected more
than one spectrum, the spectra are printed in a single graph with the row data
printed in a table beneath.

Shortcut menus

The graph in the Library Editor includes a selection of tools and a shortcut menu that
enable you to optimize and label the graph, and copy it to the Windows clipboard to be
pasted into, for example, Word.

»  To access the shortcut menu, right-click in the graph.

NOTE: To avoid infringing (c), spectra, images, and text taken from commercial

libraries cannot be copied.
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Closing the Library Editor

1. Click ¥ Close Editor.
OR
Select Close Editor from the File menu.
2.  Select Save and close library editor to confirm any changes you have made.
OR
Close without saving to disregard any changes you have made.
3. Click OK.

Additional Information
Opening and Closing Panes

»  To open or close the Dialog Pane, click the button at the center of the bottom
edge of the Viewing Area

OR
Select Dialog Pane from the View menu.

>  To open or close the Navigation pane, click the button at the center of the right
edge of the Viewing Area

OR
Select Navigation Pane from the View menu.

>  To open or close the Data Explorer, Navigation and Task Dialog panes
simultaneously, hold down the SHIFT key and click the button that opens or
closes any of these panes.

Resizing Panes

>  Open the pane, and then drag the edge of the pane containing the button (not
the button itself) to the width or height required.
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Navigation Pane - Equations

The Equations section in the Navigation pane displays shortcuts to the Equations listed in
the Setup Equations tab. New Equations are added using the Setup Equations tab.

* Click Equations in the Navigation pane to display shortcuts to the Equations
currently listed on the Setup Equations tab.

You setup an equation using Functions and Operators, and can format the results using
an If ... Then ... Else construction.

Setting up an Equation

1. Click V )‘ in the Equations section of the Navigation pane to access a user-
defined equation.

The Dialog Pane at the bottom of the Spectrum workspace, is opened (or
updated) to display the settings of that equation.

2. Select the Equation tab.
3. Amend the Equation name and Equation description as required.
The Equation name will be used in the Equations sub-menu in the Process menu.

4. Enter the Equation, either by typing directly or by clicking on items in the
Operators, Functions and Variables lists.

Every function has a number of required or optional arguments, as shown in the
syntax popup displayed when the function is selected.

Often, the first argument is <spectrum>, set to All by default, which means that
the function is applied to all selected spectra. If you want the equation to
address a particular type of sample select another of the Variables or, to address
a specific spectrum, click Browse and then select the spectrum required. All
numeric entries in the Results Table are available in the Variables List, including
numeric values from Custom columns set up in the Sample Table. If Enable
Pathlength is selected on the Setup Pathlength tab, the global pathlength defined
there will be available as a Variable (Setup_Pathlength).

5. Click Check to make sure that the syntax used in the equation is correct.

The Equation list on the Setup Equations tab is updated, but the dialog pane stays open
so that you can continue with Result Formatting. If you wish to return to the Setup
Equations tab click Back.

Your equation is available in the Equations sub-menu in the Process menu.
Formatting Equation Results

You can highlight the numeric result delivered by your equation in a different font or
color, depending on its value. Essentially, you apply an If ... Then ... Else ... condition.

1. Click v }\ in the Equations section of the Navigation pane to access a user-
defined equation.

The Dialog Pane at the bottom of the Spectrum workspace, is opened (or
updated) to display the settings of that equation.

2. Select the Results Formatting tab.

3. Set up the 'If' condition by entering a constant or selecting a result (usually you
select the result of the equation you are working on), followed by an Operator
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(such as 'greater than'), and then a Criterion (such as a constant or the result
from another equation).

The criteria available are <>, <=, >=, <, >, =, Not Between, and Between.
The Not Between and Between operators require two criteria, so you must
complete the Criterion and the Criterion 2 fields.

4. Setup the Then' conditional formatting, which specifies what happens when the
'If' section is true. Select whether to do nothing, or to label and/or highlight the
result.

To do nothing, select No formatting.

To label your result, select Replace result with text or Add text to result,
which opens a text field for you to enter your label. If no label is required, select
Only change font.

To highlight your result, you can amend its font attributes and/or the color of the
cell or row in which it is displayed. Click Change Font to amend attributes such
as Font, Font styles (italic, bold) and Size, and to apply Effects such as Color,
Strikeout and Underline. Use the Fill color drop-down selector to choose a
background color, and select the Apply to row check box if you want this color
to apply to the table row containing your result.

5. Setup the 'Else' conditional formatting, which specifies what happens when the
'If' condition is false.

Select whether to do nothing, or to label and/or highlight the result, as before.
6. If you wish to return to the Setup Equations tab click Back.

Function Reference
The Area function
Use the Area function to calculate the area under a curve between two set points. The
syntax of the function is "Area[ <spectrum variable>, Left Limit, Right Limit, Left
Base Point(optional), Right Base Point(optional)]"
For example: Area(All, 3100,3000,3150,2930) calculates the area between abscissa

positions 13100 cm™ and 3000 cm™ above a baseline with base points at 3150 cm™ and
2930 cm™.

=
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The area reported is between the Left Limit and Right Limit, either relative to a zero
baseline or relative to a linear baseline intersecting the spectrum at the specified baseline
points. If no baseline points are specified, the area reported is that above zero. If only
one baseline point is specified, a horizontal baseline is constructed from that point.
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The Yval function
Use the Yval function to obtain the ordinate value at a specified abscissa position.
The syntax of the function is "Yval[ <spectrum variable>, Abscissa position]".

For example: Yval[All, 3100] returns the ordinate value for each spectrum at 3100 cm’
1

The Yval function is useful for calculating net absorbance from the difference in
absorbance at two positions. The Yval function also enables you to determine the
amplitude of a band on a varying sloping background.

The PeakX function
Use the PeakX function to find the position of a peak or valley within a specified range.

The syntax of the function is "PeakX[ <spectrum variable>, Start Range, End
Range, Peak Threshold, 1=Peak/-1=Base,
1=Interpolated(default) /0=sampled position (optional)]".

A peak is identified by a valley that exceeds the selected threshold on either side. PeakX
gives the abscissa position of a peak or valley over the specified range. If there is more
than one peak that exceeds the threshold the routine returns the value of the first peak
or valley it finds.

For example: PeakX[All, 3500, 3000, 0.1, 1, 0] returns the first peak between
3500 cm™ and 3000 cm™ over the 0.1 threshold, and the abscissa value of the sampled
data point (as opposed to the peak position on a smooth curve fitted between the
sampled data points).

The Ymax function

Use the Ymax function to find the maximum ordinate value within a specified range,
instead of measuring the height at a fixed position. When processing many spectra, the
Ymax function enables you to address any shifts in the location of the maximum.

The syntax of the function is "Ymax[ <spectrum variable>, Start Range, End
Range]".

For example: Ymax[All, 3150, 3000] returns the maximum ordinate value between
3150 cm™ and 3000 cm™.

The Ymin function

Use the Ymin function to find the minimum ordinate value within a specified range.
When processing many spectra, the Ymin function enables you to address any shifts in
the location of the minimum.

The syntax of the function is "Ymin[ <spectrum variable>, Start Range, End
Range]".

For example: Ymin[All, 3150, 3000] returns the minimum ordinate value between
3150 cm™ and 3000 cm™.

The XYmax function

Use the XYmax function to return the abscissa position of the maximum ordinate value
found by interpolation over a specified range.

The syntax of the function is "XYmax[ <spectrum variable>, Start Range, End
Range]".
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For example: XYmax[All, 3150, 3000] returns the abscissa position for the maximum
ordinate value between 3150 cm™ and 3000 cm™.

The XYmin function

Use the XYmin function to return the abscissa position of the minimum ordinate value
found by interpolation over the specified range.

The syntax of the function is "XYmin[ <spectrum variable>, Start Range, End
Range]".

For example: XYmin[All, 3150, 3000] returns the abscissa position for the minimum
ordinate value between 3150 cm™ and 3000 cm™.

The Height function

Use the Height function to calculate the ordinate value at a specified abscissa position
relative to an optional baseline.

The syntax of the function is "Height[ <spectrum variable>, Abscissa position, Left
Base Point(optional), Right Base Point(optional)]".

For example: Height[All, 3000, 3050, 2950] returns the height at 3000 cm™ corrected
for a baseline drawn between 3050 cm™ and 2950 cm'™.

If you specify one base point, a horizontal baseline is calculated from that point. If you
specify no base points then the height is not corrected for a baseline.

The Interval function
Use the Interval function to calculate the data interval of the spectrum.
The syntax of the function is "Interval[ <spectrum variable>]".

For example: Interval[All] return the data interval of each spectrum.
The Npts function

Use the Npts function to calculate the number of data points in the spectrum.
The syntax of the function is "Npts[ <spectrum variable>]".

For example: Npts[All] returns the number of data points in each spectrum.
The End function

Use the End function to find the last abscissa point in the spectrum.

The syntax of the function is "End[ <spectrum variable>]".

For example: End[All] returns the last abscissa point in each spectrum.

You can also nest the End command within a command in place of its end value.

For example: XYmax[All, Start[All], End [All]] returns the abscissa value for the
maximum ordinate anywhere in each spectrum without having to set start and end limits.

If you use the End command with Wavelength Programmed data the last wavelength in
the list is returned.

For example: Height[All, End[All]] returns the height at the last wavelength in the list
without pre-setting that value.

The Start function
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Use the Start function to find the first abscissa point in the spectrum.

The syntax of the function is "Start[ <spectrum variable>]".

For example: Start[All] returns the first abscissa point in each spectrum.

You can also nest the Start command within a command in place of its start value.

For example: XYmax[All, Start[All], End [All]] returns the abscissa value for the
maximum ordinate anywhere in each spectrum without having to set start and end limits.

If you use the End command with Wavelength Programmed data the last wavelength in
the list is returned.

For example: Height[All, Start[All]] returns the height at the first wavelength in the
list without pre-setting that value.
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The MaxHt command

Use the MaxHLt function to determine the height of the tallest peak in a range, relative to
a baseline if required. The MaxHt function is useful for obtaining absorbance values for
quantitative applications.

The syntax of the function is "MaxHt[ <spectrum variable>, Start Range, End
Range, Left Base Point, Right Base Point]".

For example: MaxHt[All, 3150, 3050, 3200, 300] returns the height of the tallest
peak between 3150 cm™ and 3050 cm™, corrected for the baseline constructed between
3200 cm™ and 3000 cm™, using cubic interpolation between the data points.

When the Left Base Point and Right Base Point are given the same value, a
horizontal baseline is used, as shown below.

Left Base Pomt Right Base Point

The Mean, SD, and RMS functions

The Mean, SD (Standard deviation) and RMS (Root mean square deviation) functions
are standard statistical functions. When you apply them to spectral data they return the
average, standard deviation or RMS deviation ordinate value over all wavelengths.

You can use the Mean and SD functions to evaluate the results from repeated
measurements to estimate their precision and uncertainty. Use the RMS function in a
similar manner to determine variability, for example as a measure of the noise in a region
of a spectrum.

The syntax of these commands is "[ <spectrum variable> or <number variable>]".

You can apply the Mean, SD and RMS functions to spectra or to a numeric result from
another equation.

For instance, if you replicated your experiments and had an equation to find the area of a
peak in each, you could calculate the Mean of the peak areas.

The Trend function

Use the Trend function to measure a slow variation, that is a variation described as drift
rather than as noise.
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The Trend function calculates the slope of a linear fit to the spectrum. You can apply the
function to the complete spectrum or to a region within it, defined by Start Range and
End Range.

The syntax of the function is "Trend[ <spectrum variable>, Start Range (optional),
End Range (optional)]".

For example: Trend[All, 3500, 3000] calculates the slope of a linear fit to all data
between 3500 cm™ and 3000 cm™,

The Exp, Log, Sqr, Sqrt and Ln functions

Use the Exp (Exponent), Log (Logarithm), Sqr (Square), Sqgrt (Square Root), and Ln

(Logarithm base e, or natural logarithm) as standard mathematical tools that you can
apply to spectra or to the numeric results from another equation.

NOTE: If you try to take the log, natural log (Ln), or square root (Sqrt) of a

negative number, a value of zero is returned.

The Log function returns the base <n> logarithm of a number or a spectrum. The syntax
of the Log function is "Log[ <spectrum variable> or number, base]".

For example, Log[All, 10] would return the logarithm (base 10) of all your spectra.
The XVal function

Use the XVal function to determine the abscissa value at a specified Y value. The
function uses interpolation by default, which returns the actual abscissa value at the
specified Y value.

If when setting up the function, you enter 0 instead of interpolation in the syntax
statement, the function returns the abscissa value of the nearest data point.

The XVal function returns the first abscissa value at the specified Y value. If the spectrum
has more than one abscissa value at the specified Y value (such as when there is more
than one peak in the spectrum), the Search from Start / End options in the syntax
statement are useful. Select whichever end of the spectrum ensures that the required
value is returned.

The syntax of the function is "XVal[ <spectrum variable>, Ordinate value, Start
Range, End Range, 1=Search from Start(default)/-1=Search from
End(optional), 1=Interpolated(default)/0=sample position (optional)]"

NOTE: If you include the Interpolated parameter in the function, you must include
the Search from parameter. XVal[All, 1.2, 3500, 2500, 1] would search
the spectrum from the end using default interpolation, but XVal[All, 1.2,
3500, 2500, 1] where no value has been entered for the Search from
parameter (only a space between 2 commas) would return an incorrect

syntax message.

Examples:

XVal[All, 1.2, 3500, 2500, 1, 1] would return the abscissa value for all spectra at the
Y value of 1.2, between 3500 cm™ and 3000 cm™. It would start the search from

3500 cm™, and return an interpolated abscissa value, rather than the value from the
nearest data point, for each spectrum.
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XVal[All, 1.1, 3500, 3000, -1, 0] would return the abscissa value for all spectra at the
Y value of 1.1, between 3500 cm™ and 3000 cm™. It would start the search from

3000 cm™ (Search from End), and would return the abscissa value from the nearest data
point, rather than an interpolated value, for each spectrum.

XVal[All, 1.2, 3500, 3000] would return the abscissa value for all spectra at the Y
value of 1.2, between 3500 cm™ and 3000 cm™. It would start the search from 3500 cm™
(by default), and return an interpolated abscissa value (by default) for each spectrum.

Width at half height

You can use the XVal function to calculate the width of a peak at half its height:

.\Ymax {2
[~

Xmaximum

XVal[All,Ymax[All, 2535, 2545]/2,XYMax[All, 2535, 2545],2545]-
XVal[All,Ymax[All,2535,2545]/2,XYMax[All,2535,2545],2535]

This equation would look at the peak between 2535 cm™and 2545 cm™. The width at half
height will be reported for all spectra. The functions Ymax and XYMax are used to
calculate XVal. Ymax calculates the maximum ordinate value within the range. XYMax
calculates the abscissa position of the ordinate maximum.

In the first part of the equation - XVal[All, Ymax[All, 2535, 2545] / 2, XYMax[All, 2535,
2545], 2545] -

2545 means the first XVal is looked for starting from 2545 cm™.

In the second part of the equation - XVal[All, Ymax[All, 2535, 2545] / 2, XYMax[All, 2535,
2545], 2535] - 2535 means the first XVal is looked for starting from 2535 cm™.

To calculate the width at half height for any data, use the equation above and simply
replace the values (2535, 2545).

The YShift function

Use the YShift function to find the ordinate value difference at the selected position
between two linear best fit lines fitted to the data points either side of a specified x
position over a fixed width.

The syntax of the function is "YShift[ <spectrum>, x position at which to calculate
shift, x width from position for Linear Fit]".

The RCoeff function
Use the RCoeff function to calculate the correlation coefficient.

The syntax of the function is "RCoeff[ <spectrum variable>,Start Range(optional),
End Range(optional)]"
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If you do not specify Start Range and End Range values, the complete spectrum is used.

The Ri function
Use the Ri function to calculate the refractive index of your sample.

The syntax of the function is "Ri[ <spectrum variable>, Start Range, End Range,
Thickness, Num Fringes (-1=Auto), Angle of Incidence, Thickness Units:
1=A/2= u m, Peak Threshold(optional)]"

The Tcalc function
Use the Tcalc function to calculate the thickness of your sample.

The syntax of the function is "Tcalc[ <spectrum variable>, Start Range, End
Range, Refractive Index, Num Fringes(-1=Auto), Angle of Incidence, Result
Units: 1=A/2= 1 m, Peak Threshold(optional)]"

Additional Information

If you add an Equation step to a Macro, there are two additional settings on the Equation
tab that are relevant to Equations that generate spectral results.

If you want the spectrum generated by an Equation to be used as the input spectrum for
the next step, you should enable the option Use for next step.

If Use for next step is selected, you can also select to Overwrite input spectra. The
Equation will generate a new spectrum and overwrite the input spectrum. The new
spectrum generated will then be used by the next step. Any numerical results calculated
for the input spectrum will be retained.
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The Dialog Pane

Use the Dialog Pane together with the Navigation Pane to, for example, set up your
instrument.

. The Dialog Pane is at the bottom of the Spectrum workspace.

The contents of the Dialog Pane, arranged on one or more tabs, reflect the
shortcut selected in the Navigation Pane.

. The Navigation Pane is on the right of the Spectrum workspace.

The Navigation Pane contains a Setup area, which includes shortcuts to key items
from the Setup menu.

NOTE: To see a dialog, you may have to resize the Dialog Pane.

Additional Information
Opening and Closing Panes

>  To open or close the Dialog Pane, click the button at the center of the bottom
edge of the Viewing Area

OR
Select Dialog Pane from the View menu.

>  To open or close the Navigation pane, click the button at the center of the right
edge of the Viewing Area

OR
Select Navigation Pane from the View menu.

>  To open or close the Data Explorer, Navigation and Task Dialog panes
simultaneously, hold down the SHIFT key and click the button that opens or
closes any of these panes.

Resizing Panes

>  Open the pane, and then drag the edge of the pane containing the button (not
the button itself) to the width or height required.
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The Menu Bar

These reference topics describe the menus available in the Menu Bar:

Measurement

Microscope

Process

Setup

Audit Trail (ES)

Navigation

Help

Additional Information

The Measurement and Microscope items are not shown when running in the offline
mode. They are only shown when connected to an instrument.

The Menu Bar cannot be turned off, floated or customized. It is placed at the top of the
Spectrum workspace, either above or below the Instrument Settings and/or Measurement
toolbars.

NOTE: If you have Spectrum ES, and you do not have permission to perform any of the
functions on the menu, the menu will not be displayed. If you have permissions
for some, but not all, of the functions, the menu will be displayed showing only
those items for which you have permission.
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File Menu

These are the commands available in the File menu. To learn more about a command,
click on its name.

= T B 2

FEéPD TODEE®

Additional information

=2

€

E
(D
=)

Open Image View

Open Report
Send To

Export
Export to Spotfire

Report
Save

Save As
Save All
Save Image View

Print Preview
Print
Exit

CTRL+N
CTRL+O
CTRL+D
CTRL+T

CTRL+E
CTRL+F

CTRL+R
CTRL+S

CTRL+I

CTRL+P

Word
WordPad

Excel

Email

KnowItAll

Spotfire

>

Ly New Word Document
£# New WordPad Document
5% New Excel Workbook
=7 Email
AnalyzelT
SearchIT

©

For more information about opening and saving files, see Finding and Saving.

For more information about printing your results, see Publishing Results.

Send to Excel, Send to Word, Send to Spotfire and Send to KnowItAll will only be
available if you have the relevant software installed on your computer. To see the Send
to Email option, you first need to set up your email account settings on the Setup Email

tab.

do not have the appropriate permissions.

NOTE: If you have Spectrum ES, some items on this menu may not be available if you
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View Menu

These are the commands available in the View menu. To learn more about a command,
click on its name.

@ Full Range

I‘Iﬂ‘l Autorange X
# Autorange Y
I%’J Previous Range
[pg Cancel Offset
Format Graph
Add Text

(] Vertical Cursor

E Horizontal Cursor

Label Peaks

Autoscale Y
Optimize
|E| Overlay/Split
Graph Toolbars > Graph
Process
Customize
Scan Toolbars > File

Instrument Settings

Measurement

Accessory
Customize
Data Explorer
Navigation Pane

Dialog Pane

Additional Information

To view the Instrument Settings or Measurement toolbars, you must be connected to an
instrument.
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Viewing Graphs

The menu items referring to how curves are displayed can also be available on the Graph
Toolbar.

A selection of the commands are also made available in vertical toolbars displayed by the
spectra when some processes are run.

For more information about viewing graphs, see Optimizing Graphs.

Showing or Hiding Interface Elements

The menu items referring to toolbars and nes enable you to quickly show or hide parts
of the Spectrum interface. For a toolbar, indicates that the toolbar is visible. For the
Data Explorer, Navigation and Dialog Panes, indicates that the pane is open.

The toolbars displayed by default will depend on the options you selected at installation.

You can organize your workspace by hiding a toolbar, or by showing a toolbar that had
been hidden.

>  Click the icon to the left of the name of the toolbar that you want to hide
OR

Click the shaded area to the left of the name of the toolbar that you want to
show.
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Measurement Menu

These are the commands available in the Measurement menu. To learn more about a

command, click on its name.

If you are connected to an FT-IR instrument:

P> Scan

[l Scan Markers (Spotlight 200 only) >[§l Scan Markers
FE Scan and Compare
EBScan and Search
&B Scan and MultiSearch
& Scan and Verify

B3 Scanalyze > Scan and Compare
B Scan and Search
B2 Scan and Quant
P Scan and Verify

B Halt

@ Background
%5 Monitor
@ Sample Table

Instrument Checks > [E] Ready Checks

& Instrument Verification

@Comoonent Checks

> @ Run Selected
[E4Abscissa
B Noise
Throughput
L Contamination

[E5Quant Control
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(Spectrum Two only)

Standardize (AVI)

fig Humidity Shield (Spectrum Two
only)

.ﬁf Power Save Mode
(Spectrum Two only)

If you are connected to a Raman instrument:
B> Scan
B Halt
B Monitor
Bip Scanalyze > Scan and Compare
P Scan and Search

[ Scan and Quant
ﬁSamQIe Table

Additional Information

For more information about making measurements, refer to Collecting Data.

If you are connected to a Raman instrument with a Triggered Probe selected as the
Accessory, the Scan =) and Monitor 2 icons will indicate that there is a probe connected
and will be disabled. The Scan and Preview functions can only be started using the
trigger on the probe. This is to prevent accidental exposure to the laser beam when
working at a distance from the PC.

NOTE: If you have Spectrum ES, some items on this menu may not be available if you
do not have the appropriate permissions. If you do not have permission to access
any of the items on the menu, the menu will not be displayed.
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Microscope Menu

These are the commands available in the Microscope menu. To learn more about a
command, click on its name.

iﬁ; Initialize Microscope

]

1000 x 1000 pym

=
=
=

@ Stage View Range >

1 [

2000 x 2000 pm

1 [E

5000 x 5000 pm

1 [E

10000 x 10000 pm

e
(=}
=

Previous Range
Full Range

Format...

El B @ [

Stage Move > To Origin

To Selected Marker

To Background Position

B

To Load Position

B

To Previous Position

(]

To Center View

B

2 To Center Stage
[ To Coordinate...
By Image Survey
[ Analyze Image

Set Stage Origin

= Set Background Position
o

Add Marker

E| Add Line

Add Map

Additional Information

These options are also available on the toolbar in Stage View.
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Process Menu

These are the commands available in the Process menu. To learn more about a
command, click on its name.

kI Absorbance
% Transmittance

Data Tune-up

[&] Baseline Correction

[ER Interactive Baseline Correction

Difference
[&] Normalization

Interpolation

X ConvertX

[ smooth

&8 Derivative

A ATR Correction

3 Arithmetic

Mo Kubelka—Munk

S Kramers—Kronig

[i&] Deconvolution

& Biodiesel

B Peak Table

Peak Area / Height

& Quant > & Quant Analysis
% Quant Method Wizard

Com|:_Jare

§ Search
E MultiSearch
e Verify > 1% Method Name > J Material
%8 Adulterant Screen > 1"F Material
Equations > Equation n
Macros > Macro n

Additional Information

These commands are also available from a shortcut menu in the Viewing Area, and may
be included in the Process Bar.

If you have installed the Biodiesel Analyzer, Biodiesel is available on the Process menu.
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NOTE: If you have Spectrum ES, some items on this menu may not be available if you
do not have the appropriate permissions. If you do not have permission to access
any of the items on the menu, the menu will not be displayed.
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Setup Menu

These are the commands available in the Setup menu. To learn more about a command,

click on its name.

Administration (Administrators only)

Instruments

@/ g Instrument/Raman Instrument

Microscope (Spotlight 200 only)

Ready Checks

Instrument Verification

Laboratory Scheduler

Export and Email
Peak Detection

View
Pathlength
Quant

Compare

M8 Fel & BF 4 B F &

Libraries and Search (including MultiSearch)

Verify

Adulterant Screen

B &

<&  Biodiesel

{E Equations
& Macros

Restore Default Workspace

>

H 28 &

Setup Users

Users Audit Trail (ES only)

Set Group Workspace (ES only)
Add Instrument

Remove Instrument

Select Instrument

Enable Auto-Connect
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Additional Information

If you install the Biodiesel Analyzer, Biodiesel is available on the Setup menu.

The options available in the Administration sub-group of the Setup menu depend on
whether you have Spectrum Standard or Spectrum Enhanced Security installed. To view
the Administration sub-menu you must have administrator rights.

To access the Add Instrument and Remove Instrument options on the Instruments sub-
menu, you must have administrator rights.
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Audit Trail Menu (Spectrum Enhanced Security Only)

The Audit Trail menu is only available in Spectrum ES. The commands available will
depend on your permissions and the current status (for example, Locked or Unlocked) of
the workspace.

To learn more about a command, click on its name.

;}, Audit Trail
Eg

Sign
@ Review
@ Approve

@l/m Lock / Unlock

@ Return
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Navigation Menu

These are the commands available on the Navigation menu. To learn more about a
command, click on its name.

Sample Table

Samples View n

Additional Information

The Sample Table item is only available when an instrument is connected.

The number of folder items available mirrors the number of Samples Views displayed in
the Data Explorer pane. Use the Folder items to select the current Samples View.
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Help Menu

These are the commands available on the Help menu. To learn more about a command,
click on its name.

Contents
Index
Search

Tutorials > An Introduction to Spectrum

About

Additional Information

The tutorials are designed to be displayed full-screen at a resolution of at least 1280 x
768. If the vertical resolution of your display is lower, the tutorial should play, but the

playback controls may be obscured. You can exit a tutorial at any time by pressing the
ESC key.
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Toolbars

The Spectrum workspace can include a number of global toolbars:

o The Scan toolbars, namely the Instrument Settings bar, the Measurement bar,
the File bar and the Accessory bar. By default, these toolbars are located at the
top of the workspace, under the Menu bar.

. The Status bar, located at the bottom of the workspace.

The Viewing Area pane can include one or more local Graph toolbars:
o The Graph bar. By default, this toolbar is located at the top of the Viewing Area.
o The Process bar. By default, this toolbar is located at the top of the Viewing Area.

Additional Information

. The View menu includes options that enable you to select whether a toolbar is
shown or hidden.

o For information about manipulating toolbars and resetting the workspace layout,
see Showing, Hiding and Moving Toolbars.

o For information about manipulating toolbar buttons, see Personalizing Toolbars.

. You cannot customize the Status bar.
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The File Bar

Use the File bar to create new sample views, open spectra in the software, to save
spectra and publish data to other formats and applications.

g Open

E Save As
Report

@m

Additional Information

The commands displayed by default on the toolbar will depend on the option you
selected at installation. You may decide to include other view commands that you use
frequently. See Personalizing Toolbars.
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The Instrument Settings Bar

Use the Instrument Settings bar to review and, if necessary, to edit the scan settings and
the sample information for the current scan.

If you are connected to an FT-IR instrument:

Start (cm-1)

End (cm-1)

[<]

No of Scans / Scan Time

[<]

Sample ID

[<]

Description

[<]

Mode

Scan Type

Resolution (cm-1)

Ordinate Units

AVI Calibration

C0O2/H20

Phase Correction

Apodization

Scan Speed (cm/s)

Data Interval (cm-1)

B-Stop

J-Stop
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Scan Start Delay (s)

Abscissa Units

Load Setups

If you are connected to a Raman instrument:
Start (cm-1)
End (cm-1)
Accumulations
Sample ID
Description

Data Interval (cm-1)

[#] Exposure Time (s)

Additional Information

The icon above indicates that the command is included in the factory default
Instrument Settings bar. The commands displayed by default on the toolbar will depend
on the option you selected at installation. You may decide to include other view
commands that you use frequently. See Personalizing Toolbars.

For detailed information about instrument settings, see Setup Instrument or Setup
Raman Instrument.

For information about setting up sample identities, see Sample Table.
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The Measurement Bar

Use the buttons in the Measurement bar, together with the messages given in the
Prompts Display, to control your instrument.

If you are connected to an FT-IR instrument:
Prompts Display

ww

| Scan Markers > [l Scan Markers
~ (Spotlight 200 only)

% Scan and Compare
B Scan and Search

&8 Scan and MultiSearch
E% Scan and Verify

me
Background
F
% Monitor
Scanalyze > = Scan and Compare

Po Scan and Search
[% Scan and Quant
B Scan and Verify

Preview

% Sample Table



ILI Standardize

- Humidity Shield
ﬁE (Spectrum Two only)

,Z Power Save Mode
£
(Spectrum Two only)

g Macro Data Collection

If you are connected to a Raman instrument:

Prompts Display
Laser Status
[> scen

[ et
%w

Scanalyze > Scan and Compare

P Scan and Search

[%. Scan and Quant

%Scan and Compare
%M
%Scan and Quant

Preview

Workspace Reference . 545
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%Samgle Table

Additional Information

The commands displayed by default on the toolbar will depend on the option you
selected at installation. You may decide to include other view commands that you use
frequently. See Personalizing Toolbars.

You can also add Instrument Checks and Ready Checks commands to the Measurement
bar.

FT-IR Instrument

The Prompts Display is analogous to the instrument display available on some
spectrometers. This can be useful when working with multiple samples and the Sample
Table.

Macro Data Collection is only available when running a Data Collection step of a macro.

The Spectrum Two Power Save Mode option is disabled during data collection.
Raman Instrument

The Raman Laser Status icon provides information about the current state of the laser. It
also provides important safety information about your system. For example:

. Laser off

SV
o Laser stabilizing

. i Laser on, shutter closed

o %Laser on, safety interlock breached

. 1 Class 1 system, laser on, shutter open or ready to open

. ﬁdass 3B system, laser on, shutter open or ready to open.

If you are connected to a Raman instrument with a Triggered Probe selected as the
Accessory, the Scan | ~"™ and Monitor ' icons will indicate that there is a probe
connected and will be disabled. The Scan and Preview functions can only be started using
the trigger on the probe. This is to prevent accidental exposure to the laser beam when
working at a distance from the PC.
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The Accessory Bar

The Accessory Bar contains controls appropriate to the accessory currently installed in
the instrument. The toolbar includes an icon that identifies the accessory installed. If you
change the sampling accessory, the Accessory bar will automatically be updated with the
new accessory controls.

Additional Information
If your instrument configuration includes a Spotlight microscope, the Accessory bar will

contain the Microscope icon. If you click ﬁ then the Setup Microscope tabs are
displayed.

You can personalize toolbars by adjusting their appearance and by showing, hiding and
re-arranging buttons. See Personalizing Toolbars.




548 . Spectrum User’s Guide

The Graph Bar

Use the Graph bar to optimize how your spectra are displayed, particularly prior to
printing, or cutting and pasting into another application.

%Auto XY
\Q_J'_l‘[ Auto X
@Auto Y

gl_%jm

Cancel Offset

ab] ™

Vertical Cursor

=
=

Horizontal Cursor

=
=]
=

u

E

Labels

Autoscale Y

Optimize

& =

Split

HE

Reset Toolbar

Additional Information

The commands displayed by default on the toolbar will depend on the option you
selected at installation. You may decide to include other view commands that you use
frequently. See Personalizing Toolbars.
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The Process Bar

Use the Process bar to select a process to apply to your selected spectrum.

Absorbance

Transmittance

&

Data Tune-up

Baseline

% i-Baseline

Difference

W
e
X
o

d
dx

1
ATR

-
+x

X

X Kramers—Kronig

R

Normalization

Interpolate

ConvertX

Smooth

Derivative

ATR Correction

Arithmetic

Kubelka—Munk

Deconvolution
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@  Biodiesel
L ;
"“f

TTTTT]

# Ppeak Table
N

Ill Peak Area / Height
% Quant
Compare
% Search
I@ MultiSearch

EIgR ™

@Adulterant Screen

=‘Ji Equations

g Macros

Reset Toolbar

Additional Information

The icon above indicates that the command is included in the factory default Process
bar.

If you have the Biodiesel Analyzer installed, the process Biodiesel and the Macros
Biodiesel HATR and Biodiesel UATR will be included in the default Process bar.

You may decide to include other process commands that you use frequently. See
Personalizing Toolbars.

These commands are also available from a shortcut menu in the Viewing Area, and from
the Process Menu.
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The Status Bar

The Status bar is a global toolbar that is displayed at the bottom of the Spectrum
workspace.

The Status bar reports the name of the user who is currently logged in, and whether
Spectrum is working Offline or is connected to an instrument.
When Spectrum is connected to an instrument, the Status bar reports whether:

. The connection to a networked instrument is healthy.

. The instrument is Idle or Scanning.

. The instrument requires servicing, or its desiccant requires changing.

. The J-stop card needs changing for the current resolution. This is relevant for
spectrometers that do not have an automated, internal J-stop.

o The Mode of your dual-range spectrometer has been changed since you last used
the instrument.

The Status Bar also reports:

o The current status of the Microscope if a Spotlight is connected to the instrument.
For example, if the microscope is initializing or an aperture calibration is in
progress. Also the status of the battery in the microscope weighbridge (if fitted to
the stage).

. The current status of the Raman laser, if you are connected to a Raman
instrument. For example, Off, Stabilizing, On with shutter closed, On with shutter
open or On with laser safety interlock breached.

. The current status of the Raman detector, if you are connected to a Raman
instrument. For example, whether the detector is cooling, and the current
temperature of the detector.
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Showing, Hiding and Moving Toolbars

Showing and Hiding Toolbars

You can organize your workspace by hiding a toolbar, or by showing a toolbar that had
been hidden.

> In the View menu, click the icon to the left of the name of the toolbar that
you want to hide
OR

Click the shaded area to the left of the name of the toolbar that you want to
show.

NOTE: The Menu and Status bars cannot be hidden.

Moving, or Floating, a Toolbar

When a toolbar is unlocked, a dotted drag handle is displayed, usually on its left edge.
This handle enables you to change the position of a toolbar, or to float it in a separate
window.

»  Place your mouse pointer over the drag handle on the toolbar you want to move
and drag it to its new position.

Locking Toolbars

Locking a toolbar protects it from some inadvertent changes. A locked toolbar can be
hidden, and its buttons re-arranged or reset, but it cannot be customized or dragged to a
new location.

>  Right-click the button to the right of the toolbar and then click Lock The
Toolbars.

The toolbars are locked when is displayed to the left of this command.

NOTE: The toolbars are grouped so that, for example, locking one of the Scan toolbars
locks the Instrument Settings and Measurement toolbars, or locking one of the
Graph toolbars locks the Graph and Process toolbars.

Restoring the Workspace
Spectrum Standard

Restore Default Workspace will return your workspace, including instrument settings and
other default parameters, toolbar buttons and the layout, to the system default. No
macros, equations, instrument setups or sample table setups will be removed.



Workspace Reference . 553

To restore the workspace to the system default:

1.

2.

Select Reset Layout from the Setup menu.

The Reset Layout dialog is displayed.

Click OK to confirm the reset.

Spectrum closes briefly, and then opens with the system default layout.

Spectrum ES

Restore Default Workspace will return your workspace, including instrument settings and
other default parameters, toolbar buttons and the layout, to the group or system default.
Any user macros, equations, instrument setups or sample table setups will be removed.

To restore the workspace to the group or system default:

1.

Select Restore Default Workspace from the Setup menu.
The Restore Default Workspace dialog is displayed.
Click OK to confirm the reset.

If you are a member of a group with a group default workspace, then the group
workspace will be loaded. If not the system default will be loaded.

If you are a member of more than one group, the Set Group Workspace dialog is
displayed.

Select which group workspace you want to load.
Members of the Administrators group can select the system default.
Click OK.

Any unsaved data in the current workspace will be saved. If a signature is
required, the Sign workspace dialog will be displayed for you to enter a signature.
The workspace closes. Spectrum then reloads with the selected workspace
displayed.

Additional Information

For information about manipulating toolbar buttons, see Personalizing Toolbars.

For information about adding or removing toolbar buttons or menu items, see
Customizing Toolbars and Menus.

You cannot personalize or customize the Status bar.
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Personalizing Toolbars

You can personalize toolbars by adjusting their appearance and by showing, hiding and
re-arranging buttons.

NOTE: The toolbars are grouped so that, for example, changing the appearance of the

Graph toolbars changes the appearance of both the Graph Toolbar and the

Process Toolbar.

Displaying and Positioning Text

By default, toolbars are displayed with command names placed under below the
command icon.

1.

4.

In the View menu, select Graph Toolbars or Scan Toolbars, and then select
Customize.

OR

Right-click the button to the right of a toolbar and then click Customize.
The Customize dialog is displayed.
Select the Toolbars Text tab.

By default, the Show both text and images in toolbars option is enabled
(checked) and the Text below image option is selected.

If you want to display the toolbar buttons without text, deselect (uncheck) the
Show both text and images in toolbars option.

OR
Select one of the text display options.
Click Close.

Changing the Icon Size

1.

In the View menu, select Graph Toolbars or Scan Toolbars, and then select
Customize.

OR

Right-click the button to the right of a toolbar and then click Customize.
The Customize dialog is displayed.

Select the Options tab.

By default, the Large Icons in Toolbars option is enabled (checked).

If you want to display the toolbar buttons with smaller icons, as used in the
menus, disable (uncheck) the Large Icons in Toolbars option.

Click Close.
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Showing and Hiding Buttons

The toolbars are, by default, populated by standard sets of buttons (that is, icons or text
entry fields), which depend on the Installation Type selected when Spectrum was
installed. You can organize your workspace by hiding any buttons that you do not use
very often, or by showing a button that had been hidden.

Click the button to the right of the toolbar you want to modify, select Add or

Remove Buttons, the name of the toolbar, and then click the icon to the
left of the name of the button that you want to hide,

OR

Click the shaded area to the left of the name of the button that you want to
show.

Re-arranging Buttons on a Toolbar

You can arrange the buttons in the toolbars to suit your preferred method of working.

1.

Hold down the ALT key and select the edge of the button you want to move.
The button is surrounded by a black box.
Drag the button to its new position on the toolbar.

The button is placed at the position of the cursor.

Resetting a Toolbar

>

Click the button to the right of the toolbar you want to reset, select Add or
Remove buttons, the name of the toolbar, and then click Reset Toolbar.

The toolbar is reset to include all the icons available for that toolbar.

Additional Information

For information about manipulating toolbars and resetting the workspace layout,
see Showing, Hiding and Moving Toolbars.

For information about adding or removing toolbar buttons or menu items, see
Customizing Toolbars

You cannot customize the Status bar.
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Customizing Toolbars and Menus

Adding Buttons to a Toolbar

You can customize a toolbar by adding buttons that are not simply hidden in the current
setup. For example, you can add a button that is usually displayed in another toolbar.

1.

In the View menu, select Graph Toolbars (if you want to customize the Graph
toolbar or Process toolbar) or Scan Toolbars (if you want to customize the File
toolbar, Instrument Settings toolbar or Measurement toolbar), and then select
Customize.

OR

Right-click the button to the right of the toolbar, click Add or Remove
Buttons and then click Customize.

The Customize dialog is displayed.
Select the Commands tab, and then click Rearrange Commands.
The Rearrange Commands dialog is displayed.

Select the Toolbar option, select the toolbar you want to customize, and then
click Add.

The Add Command dialog is displayed.

Select from the Categories of command available, and then select the
Command you want to add.

You can select any available command from the All Commands category.
Click OK.

The command is added to the list of commands that you can rearrange.
Position the command in the toolbar by clicking Move Up and Move Down.

If you want to insert a separator 'below' a button (as listed in the dialog, usually
to the right of the button when the toolbar is displayed), click Modify Selection
and select the Begin a Group option.

Click Close.
Click Close to shut the Customize dialog.

NOTE: Although you can use the Rearrange Commands dialog to delete a command

from a toolbar, you may prefer to simply hide it.

Creating a New Toolbar

You can create a new toolbar containing any of the available commands, such as those
needed for a particular task. You could hide the toolbar when it is not needed.

You associate a new toolbar with either the Graph toolbars (that is, the Graph toolbar
and the Process toolbar) or with the Scan toolbars (that is, the Accessory toolbar, File
toolbar, Instrument Settings toolbar and the Measurement toolbar).

1.

In the View menu, select Graph Toolbars or Scan Toolbars, and then select
Customize.

OR
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Right-click the
The Customize dialog is displayed.

button to the right of a toolbar and then click Customize.

Select the Toolbars tab, and then click New.

The New Toolbar dialog is displayed.

Enter a Toolbar name and its default Location, and then click OK.

The New Toolbar dialog closes, and an empty toolbar is added to Spectrum.

The toolbar name will be added to the appropriate sub-menu in the View menu,
which enables you to show or hide it.

If you want the toolbar to be hidden by default, deselect the checkmark to the
left of its name in the Toolbars pane.

To populate your toolbar, continue from Step 2 in Adding Buttons to a Toolbar.
OR
Click Close.

Customizing the Menu Bar

NOTE: The menu system is very flexible, but there are some restrictions. For example,

some sub-menus are treated separately and not every command is available.

You cannot add a new menu to the Menu bar, or add a command that does not exist.
However, you can simplify @ menu by not displaying a command that you never you use,
display a command in another menu, or rearrange a menu to make a useful command
more prominent.

1.

In the View menu, select Scan Toolbars, and then select Customize.
OR

Right-click in the Menu bar and then click Customize.

The Customize dialog is displayed.

Select the Commands tab, and then click Rearrange Commands.
The Rearrange Commands dialog is displayed.

Select the Menu Bar option, and then select the menu or sub-menu that you
want to customize.

If any of the existing commands in the menu can be modified, they are listed in
the Commands pane.

If you want to add a command to the menu, click Add, select the command from
the Add Command dialog, and then click OK.

The command is added to the list of commands that you can rearrange.

Position a selected command in the menu by clicking Move Up and Move
Down, or remove it by clicking Delete.

If you want to insert a separator below a command, click Modify Selection and
select the Begin a Group option.

Click Close.

Click Close to shut the Customize dialog.
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Additional Information

. For information about manipulating toolbars and resetting the workspace layout,
see Showing, Hiding and Moving Toolbars.

o For information about manipulating toolbar buttons, see Personalizing Toolbars.

. You cannot customize the Status bar.
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Glossary

A

Absorbance: Traditionally, the absorbance scale has been used for quantitative work on
spectra. The transmittance scale has been used for interpretation.

Alignment: In this context, alignment is the adjustment of the interferometer mirror
angles to optimize the amplitude of the interferogram centerburst.

Apodization: The true interferogram of a light source is infinite in length. A
spectrometer can only measure a finite part of the interferogram; this means that
unwanted oscillations or sidelobes are produced on either side of narrow bands in the
spectrum. Apodization is a mathematical function that removes the sidelobes.

ATR: Attenuated Total Reflectance. ATR correction makes a spectrum collected with an
ATR accessory similar to a transmittance spectrum so the two types of spectrum can be
compared.

AVI: Absolute Virtual Instrument. AVI correction measures the current instrument
performance relative to an absolute standard (the methane cell in the filter wheel) and
an ideal lineshape function, and applies a correction.

Baseline correction: Baseline correction removes baseline features from your
spectrum, such as a baseline slope caused by scattering.

Beamsplitter: The beamsplitter is a plate with approximately equal transmittance and
reflectance, used to generate and recombine the two beams in the interferometer.

C

C02/H20 Suppression: An atmospheric correction routine that also overcomes non-
linearity due to resolution; temperature dependence; and the effects on lineshape and
calibration caused by J-stop and the sample or accessory.

D

Data Interval: The data interval, or digital resolution, refers to the abscissa spacing of
data points in a spectrum or interferogram. The unit for the spectral data interval is the
wavenumber (cm-1) and for interferogram data it is the number of interferogram data
points collected.

Derivative: Derivative spectra usually have sharper features than the original spectra. In
quantitative analysis, they are sometimes used to reduce the effects of overlapping
bands. The elimination of some baseline effects in derivative spectra can be useful in
quantitative methods. Second-derivative spectra have sharp minima where there are
maxima in the original spectrum and so can be used to identify band positions in complex
regions.

Difference: A weighted subtraction of one spectrum from another.

F

FT-IR: Fourier Transform - Infra Red. A generic term, but usually refers to a
spectrometer optimized for the mid-infrared region.

FT-NIR: Fourier Transform - Near Infra Red. A spectrometer optimized for the near-
infrared region.
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Interpolate: If the features in a spectrum are sufficiently wide, fewer datapoint may be
needed to define them. Interpolate adds and removes datapoints to create a copy of a
spectrum constructed from a smaller dataset.

J

J-stop: Jacquinot stop. The aperture setting that restricts beam divergence to the
maximum acceptable for the required resolution.

Normalize: A function used to set a common peak in several spectra to the same
ordinate limit so that other peaks within the spectra can be compared.

o

Optimize: A display function, rather than a data transform, that ignores dominant noise
spikes or peaks from atmospheric carbon dioxide or water vapor, so that you display
features of interest more easily.

R

Reference material: A material (stable, homogeneous) one or more properties of
which are sufficiently well-established to be used for the calibration of apparatus, the
assessment of a measurement method, or for assigning values to materials.

S

Spectrum: Proprietary software used to control a PerkinEImer spectrometer; and to
display, process, and store the data sets (a spectrum or series of spectra) collected.

Spectrum file: A file that contains a spectrum. Spectrum files have the extension *.sp

T

Transmittance: Traditionally, the transmittance scale has been used for interpretation
of spectra. The absorbance scale has been used for quantitative work.
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